
 

BAB   III 

PEMBAHASAN  
 

 

3.1 Analisis Kebutuhan Calon Konsumen  

Sebelum memutuskan akan membeli sebuah produk, tentunya konsumen 

akan berusaha mendapatkan informasi lebih jauh tentang produk yang akan dibeli 

dan dalam hal ini sebuah cd film animasi jepang (anime) yang terdiri dari berbagai 

judul dan kategori / jenis.  Berdasarkan survei di lapangan, para calon pembeli 

biasanya mencari informasi di majalah-majalah anime tentang jenis film (action, 

drama, fiksi, dll), gambar animasinya, ratingnya, dan garis besar ceritanya 

sebelum memutuskan untuk membeli cd film tersebut.   

 

3.2   Struktur Navigasi Website 

 Struktur Navigasi Website digunakan untuk menggambarkan secara garis 

besar isi dari seluruh situs web dan menggambarkan bagaimana hubungan antara 

isi-isi tersebut dan apa keterkaitannya satu sama lain. Struktur navigasi website 

x~anime ini adalah Struktur Navigasi Campuran. Sebelum menyusun struktur 

navigasi website, yang dilakukan adalah mengumpulkan materi-materi yang akan 

ada dalam website. Melalui struktur navigasi website ini, terlihat bagaimana isi 

dan susunan dari sebuah website secara menyeluruh. Untuk situs web x~anime ini 

maka isi yang ada antara lain: Anime list (daftar judul yang tersedia), Kategori 

(action, sport, fantasy, drama, joke n fun, detective, adult/hentai, tokusatsu, j-

movie), capture list , sinopsis (garis besar cerita dari setiap anime), screen capture 

(gambar cuplikan dari setiap anime), Daftar Biaya Kirim, About Us (tentang 

kami), dan Pemesanan. Diagram struktur navigasi website x~anime dapat dilihat 

pada gambar 3.1. 
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3.3 Storyboard 

Storyboard dibawah ini menggambarkan keterkaitan link-link pada setiap 

halaman dan menjelaskan arah komunikasinya, apakah satu arah atau dua arah 

(bolak-balik) antar halaman yang tersedia pada website x~anime. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.2 Storyboard Website X~Anime 

Keterangan : 

 Setiap halaman yang ada di website X~Anime saling terhubung satu 

sama lain, dan saling berkaitan. Sub-sub halaman dari link Pilih Kategori yang di 

bagi berdasarkan pengelompokan jenis, hanya dapat diakses dari link Pilih 

Kategori. Sedangkan halaman Sinopsis dan Screen Capture dapat diakses dari 

halaman List Anime, List Capture, dan halaman-halaman sub kategori. 

  

Pembuatan struktur navigasi dan storyboard website dari x~anime akan 

sangat membantu nantinya ketika akan membuat rancangan seluruh halaman web 

sebagai gambaran proses-proses apa saja yang dapat terjadi dalam website. 

Struktur navigasi website yang baik adalah yang  mampu memberitahukan kepada 

pengunjung tentang lokasi mereka sekarang, lokasi-lokasi yang bisa dikunjungi 

dari lokasi sekarang. 
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3.4    Rancangan Desain Website X~Anime 

Pada bab ini akan dibahas tentang seluruh rancangan masing-masing 

halaman website x~anime, yaitu, Rancangan Menu Utama.htm, Rancangan 

Kategori.htm, Rancangan SubKategori.htm, Rancangan Anime List, Rancangan 

Screen Capture.htm, Sinopsis.htm,, Rancangan Pemesanan.htm, Rancangan 

About Us.htm, Rancangan Biaya Kirim.htm. 

 

3.4.1 Rancangan Menu Utama.htm 

Halaman ini berisi kata penghantar dan perkenalan bagi pengunjung 

website x~anime karena halaman Menu utama.htm merupakan halaman depan 

dari semua halaman yang ada pada website x~anime dan pada kata perkenalan itu 

juga dijelaskan secara singkat tentang kelebihan dan cara akses website ini. 

Halaman ini juga dapat disebut sebagai halaman pembuka, karena pada saat 

pertama website dibuka maka halaman inilah yang akan tampil sebelum halaman 

yang lainnya maka halaman ini harus didesain semenarik mungkin hingga 

membuat pengunjung tertarik dan penasaran untuk mnjelajah lebih dalam. 

 Rancangan halaman Menu utama.htm menggunakan tiga frame 

sehingga selanjutnya perubahan / pergantian halaman hanya terjadi pada frame 

kiri (left frame) dan frame utama (main frame) dikarnakan frame atas (top frame) 

hanya digunakan sebagai header dari website x~anime. Rancangan halaman menu 

utama.htm mempunyai rancangan tampilan sebagai berikut :  

 

 
 
 
 
 
 
 
 
 
 

Gambar 3.3  Rancangan tampilan Menu utama.htm 
 

Gambar 3.3  Rancangan Tampilan Menu Utama.htm 
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3.4.2 Rancangan Kategori.htm 

Pada halaman ini merupakan menu pemilihan judul berdasarkan kategori 

dari website x~anime. Peng-kategori-an berdajarkan jenis film dianggap sangat 

penting karena akan sangat memudahkan pengunjung untuk menemukan film 

anime yang sesuai dengan keinginannya. Cd anime dikategorikan / disub -

kategorikan menjadi halaman-halaman : Action, Drama joke n fun, Detective, 

Fantasy, Adult / Hentai, Sport, J-Movie, dan Tokusatsu.  

Kategori.htm merupakan halaman kedua dari frame kiri (left frame), 

sehingga sebelum mengklik salah satu text link dari kategori yang ada maka 

tampilan frame utama (main frame) tidak akan berubah. Pada halaman ini, 

memang hanya terlihat bagian kiri dari seluruh halaman dikarnakan dari tengah 

hingga kekanan tertutup oleh halaman tengah (main frame). Dikarnakan posisi 

gambar akan mengantung dipojok kiri atas halaman ini maka akan digunakan 

fasilitas layer ( ditandai dengan garis               ) yang tersedia pada menu 

Macromedia Dreamweaver untuk membungkus gambar agar gambar dapat diatur 

sesuai keinginan  Rancangan halaman Kategori.htm mempunyai rancangan 

tampilan sebagai berikut :  

 

 

 
 
 

 
 
 
 
 

 
 
 

 

 

Gambar 3.4  Rancangan Tampilan Kategori.htm 
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3.4.3 Rancangan SubKategori.htm 

Pada halaman ini berisi daftar judul-judul anime yang masuk dalam jenis 

kategori seperti yang telah disebutkan diatas, link-link menuju sinopsis (garis 

besar cerita), screen capture (cuplikan gambar) dan informasi lainya dari tiap-tiap 

judul. Pada masing-masing subkategori memiliki tampilan yang sama, yang 

membedakan hanya datanya saja. 

Halaman ini merupakan perubahan tampilan halaman frame utama (main 

frame) jika di klik salah satu text link kategori di halaman Kategori .htm yang 

merupakan halaman kedua frame kiri (left frame). Halaman Sub kategori hanya 

terdiri dari text, text link dan tabel yang berisi daftar judul dari website x~anime 

yang dikelompokan berdasarkan kategori yang dipilih, dan banyaknya text link 

pada tabel tergantung dari banyaknya judul dalam kategori tersebut. Adapun 

rancangan tampilan halaman subkategori.htm adalah sebagai berikut :  

 

 

 

 

 

 

 

Gambar 3.5  Rancangan Tampilan SubKategori.htm 

 

3.4.4 Rancangan Anime List.htm 

Pada halaman ini juga merupakan perubahan tampilan frame utama 

(main frame) jika diklik text link Sinopsis&List anime. Halaman Anime List.htm 

berisi daftar judul dari semua judul yang tersedia pada website x~anime dan 

merupakan link menuju Sinopsis.htm yang merupakan informasi lebih detail dan 

garis besar cerita (sinopsis) dari text link judul yang dipilih. Rancangan halaman 

Anime List.htm mempunyai rancangan tampilan sebagai berikut :  
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Gambar 3.6  Rancangan Tampilan Anime List.htm 

 

3.4.5       Rancangan Sinopsis.htm 

Halaman ini merupakan perubahan tampilan frame utama (main frame). 

Pada halaman ini berisi informasi tentang sinopsis / garis besar cerita dari film 

yang di klik link-nya di anime list.htm. Pada halaman ini berisi informasi detil 

tentang anime tersebut diantaranya adalah jumah episode, sutradara, disainer 

karakter, Produser / Stasiun TV yang menayangkan, dan juga judul aslinya. 

Secara keseluruhan, halaman ini terdiri dari text dan gambar, sedangkan fungsi 

tabel (transparan, ditandai dengan garis putus-putus) hanya sebagai pembatas 

posisi text agar teratur dan enak dipandang. Halaman Sinopsis.htm mempunyai 

rancangan tampilan sebagai berikut :  

 

 

 

 

 

 

 

 

 

Gambar 3.7  Rancangan Tampilan Sinopsis.htm 
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3.4.6 Rancangan Capture List.htm 

Halaman ini memiliki tampilan yang serupa dengan Anime List.htm. 

Hanya saja link-link pada halaman ini menghubungkan pada ScreenCapture.htm 

atau halaman cuplikan gambar dari tiap-tiap judul yang tersedia. Capture List.htm 

mempunyai rancangan tampilan sebagai berikut :  

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.8  Rancangan Tampilan Capture List.htm 

 

3.4.7 Rancangan Screen Capture.htm 

Halaman ini juga merupakan pergantian halaman dari frame utama 

(main frame). Di halaman ini berisi kumpulan cuplikan gambar film dari judul 

yang dipilih sebelumnya yang sudah diedit menggunakan adobe photoshop. 

Halaman ini akan muncul jika diklik link bertuliskan Screen Capture. Dan text 

link yang berada pada bagian bawah gambar adalah link menuju sinopsis dari 

screen capture yang dipilih. Rancangan halaman Screen Capture.htm mempunyai 

rancangan tampilan sebagai berikut :  
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Gambar 3.9  Rancangan Screen Capture.htm 

 
3.4.8 Rancangan Pemesanan.htm 

Halaman ini juga merupakan pergantian halaman dari frame utama 

(main frame). Halaman ini berisi tentang informasi cara pembelian melalui e-mail 

dan SMS juga informasi pilikan paket pembalian cd anime. Rancangan halaman 

Pembelian.htm mempunyai rancangan tampilan sebagai berikut :  

 

 

 

 

 

 
 

                
 

Gambar 3.10  Rancangan Pemesanan.htm 
 

3.4.9 Rancangan About Us.htm 

Halaman ini juga merupakan pergantian halaman dari frame utama 

(main frame). Halaman ini membahas tentang latar belakang sejarah dari situs 

x~anime, dan juga informasi mengenai apa yang bisa mereka dapatkan dari situs 

x~anime Rancangan halaman About Us.htm mempunyai rancangan tampilan 

sebagai berikut :  
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Gambar 3.11  Rancangan Tampilan About Us.htm 

 
 
 
3.5   Rancangan Tampilan  Website X~Anime 

Proses pembuatan tampilan Website ini dilakukan dengan 3 (tiga) tahap, 

yaitu: pembuatan situs baru, pembuatan isi tampilan website dan pembuatan link 

pada tampilan website. 

 

3.5.1 Memulai Website Baru 

 Langkah-langkah memulai pembuatan website baru: 

1. Untuk memanggil program aplikasi dreamweaver, Klik Start > 

Program > Macromedia > Macromedia Dreamweaver MX. 

       
Gambar 3.12 Tampilan Memulai Aplikasi  

Macromedia Dreamweaver MX 
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2. Maka akan muncul tampilan seperti pada gambar di bawah ini. 

    
                Gambar 3.13 Tampilan Ruang Kerja Dreamweaver MX 

 

3. Untuk memulai dokumen baru. Pilih File > New. Maka akan muncul 

tampilan seperti pada gambar di bawah ini. 

 
Gambar 3.14 Tampilan Untuk Masuk Ke New Document 

 

Pada kotak dialog New Document, pilih general, pada category pilih 

Framesets > Fixed Top, Nested Left. Setelah itu klik create.  

 

 
                            Gambar 3.15 Tampilan New Document 



   

4. Maka akan muncul tampilan seperti pada gambar di bawah ini. 

 
 Gambar 3.16 Tampilan Untitled Document (Untilted Framesets) 

5. Lalu pilih menu Site > New Site. Maka akan muncul tampilan seperti 

pada gambar di bawah ini. 

 
              Gambar 3.17 Tampilan Membuat Site Definition 

 

3.5.2 Membuat Folder Baru Untuk Website X~Anime 

Untuk merancang website baru, sebelumnya buatlah sebuah folder atau 

directory baru dengan nama “X~Anime Website”  melalui windows explorer yang 

berfungsi untuk menyimpan semua halaman situs. Kemudian buat bebrapa folder 

lagi di dalam folder “X~Anime Website” dengan nama “Gambar”, “Halaman” 

lalu buat lagi beberapa subfolder didalam folder Gambar yaitu folder 

“image_capture” untuk menaruh file-file gambar screen capture, folder 

“image_sinopsis” untuk menaruh gambar dari halaman sinopsis, dan “Objects” 

untuk menaruh semua gambar-gambar lain yang digunakan pada website. Lalu 

didalam folder “Halaman” buat juga folder-folder dengan nama “detailanime” 

untuk menyimpan halaman-halaman sinopsis, “KATEGORI” untuk menyimpan 

halaman-halaman subkategori (terdiri dari halaman : action, adulthentai, detective, 



   

drama n fun, fantasy, j-movie, sport, tokusatsu), kemudian buat folder 

“SampelCapture” untuk menyimpan halaman-halaman screen capture, dan yang 

terakhir buat folder “HalamanAwal” untuk menyimpan sisa halaman lainnya 

yang digunakan pada website ini. Langkah-langkah membuat folder atau directory 

untuk sebuah website (situs) baru adalah sebagai berikut: 

a. Langkah pertama 

Di dalam Dreamweaver MX, untuk membuat website perlu 

mendefinisikan situs dengan menggunakan kotak dialog Site 

Definition. Pada kotak dialog site definition tersebut, diminta untuk 

menentukan situs yang dibuat. Dalam proses pendefinition, ada dua 

cara yang dapat di kerjakan, yaitu dengan menggunakan pilihan 

Basic (memberikan kemudahan dalam menyiapkan situ) atau pilihan 

Advanced (bila sudah paham betul akan konsep yang berlaku pada 

dreamweaver mx 2004). Pilihlah kategori basic bagi yang masih 

memerlukan langkah-langkah pertama pembuatan situs. Perhatikan 

nama situs pada kolom “What would you like to name your site?” 

Nama dapat diisi sesuai keinginan, sebagai contoh: 

“X~Anime_online”. Seperti pada gambar di bawah ini. 

 
Gambar 3.18 Tampilan Langkah Pertama  

New Site Wizard Kategori Basic 

 

b. Langkah Kedua 

Klik next untuk melanjutkan langkah berikutnya sehingga akan 

tampil seperti gambar di bawah ini. 



   

 
Gambar 3.19 Tampilan Langkah Kedua  

New Site Wizard Kategori Basic 

Di dalam gambar, pada kolom “Do you want to work with a server 

technology such as ColdFusion, ASP.NET, ASP, JSP, or PHP?” 

Pilih No, apabila situs yang akan dibuat adalah situs statis dan tidak 

memiliki halaman yang dinamis. Pilih Yes, apabila Apabila situs 

yang akan dibuat dengan menggunakan teknologi dan aplikasi 

server, seperti: Microsoft ASP.net (Active Server Pages), 

Macromedia Coldfusion, JSP (Java Server Pages), atau PHP. Pilihlah 

No pada langkah ini. 

 

c. Langkah Ketiga 

Setelah itu, klik next untuk melanjutkan langkah berikutnya 

sehingga akan tampil gambar di bawah ini. 

 
Gambar 3.20 Tampilan Langkah Ketiga  

New Site Wizard Kategori Basic 



   

Di dalam Kotak dialog ini, pada kolom “How do you want to work 

with your files during development” , pilih “Edit local copieson my 

machine, then upload to server when ready (recommended)”. 

 Setelah itu tentukan tempat penyimpanan file pada harddisk 

dengan mengetikkan folder penyimpanan pada bagian kotak teks 

yang disediakan, atau dengan mengklik ikon folder disebelah kanan 

kotak teks sehingga tampil kotak dialog Choose Local Root Folder. 

Tentukan drive yang anda inginkan seperti pada gambar, jika anda 

sudah menentukan pilihan anda, klik tombol select.  

 
Gambar 3.21 Tampilan Choose Local Root Folder 

 

d. Langkah Keempat 

Pada Kotak dialog ini. Pada “How do you connect to your remote 

server?”, pilih “Local/Network” untuk bekerja secara lokal. Pada 

“What folder on your server do you want to store your files in?”, 

tentukan folder untuk menyimpan seluruh file. Klik next untuk 

masuk pada kotak dialog selanjutnya.  

 
Gambar 3.22 Tampilan New Site Wizard Kategori Basic 



   

e. Langkah Kelima 

 Pada kotak dialog ini, “Do you want to enable checking in and 

checking out files, to ensure that you and your co-workers cannot 

edit the same file at the same time”. Pilih Yes, apabila anda 

memperbolehkan pengecekan files. Pilihlah No, apabila anda tidak 

memperbolehkan pengecekan files. Pada kotak dialog ini, pilihlah 

No.  

  
              Gambar 3.23 Tampilan Langkah Kelima 

   New Site Wizard Kategori Basic 

 

f. Langkah Keenam 

Klik next untuk melanjutkan langkah berikutnya sehingga akan 

tampil seperti gambar di bawah ini. 

 
Gambar 3.24 Tampilan Langkah Keenam  

New Site Wizard Kategori Basic 

 Pada langkah keenam atau terakhir adalah laporan dari apa yang 

telah dimasukkan, pilih done utnuk melanjutkannya. Langkah di atas 

adalah apabila anda memilih kategori basic pada newsite.  



   

3.6 Pembuatan Halaman Website X~Anime 

Pada sub-bab ini akan dibahas satu-persatu bagaimana proses pembuatan 

setiap halaman web, yaitu tampilan halaman Menu Utama.htm, Kategori.htm, 

SubKategori, Anime List.htm, Sinopsis.htm, Capture List.htm, Screen 

Capture.htm, Pemesanan.htm, dan About Us.htm. 

 

3.6.1 Pembuatan Halaman Menu Utama.htm 

 Halaman menuutama.htm merupakan halaman terdepan. Pada 

pembuatan halaman menu utama.htm ini menggunakan background color, text 

biasa dan text animasi, tabel, image,. Halaman ini juga menggunakan table 

sebagai tempat menampilkan image agar tidak bergeser ketika di-upload. Pada 

halaman menuutama.htm juga menggunakan tiga image yaitu berupa gambar yang 

dibuat menggunakan adobe photoshop, satu animasi dengan menggunakan 

aplikasi Bannermaker Pro 5.0., dan menggunakan fasilitas layer yang tersedia 

pada Dreamweaver MX. Dikarnakan halaman ini menggunakan tiga frame, maka 

masing- masing frame harus di save dengan nama atas.htm untuk top frame, 

kiri.htm untuk left frame, dan tengah.htm untuk main frame ( seperti yang sudah 

dijelaskan pada bab 6.4.1 ). 

Langkah-langkah pembuatan tampilan halaman menuutama.htm, adalah 

sebagai berikut: 

      

1. Mendesain frame tengah.htm 

• Membuat latar belakang dengan image (background image)  

 Pada frameset yang sudah di save dengan nama 

X~Anime_index.htm. klik halaman yang berada di tengah lalu ambil 

gambar (browse) pada folder yang di tuju.  

 Yaitu dengan cara: Klik Modify > Page Properties > Browse. 



   

 
Gambar 3.25 Tampilan Cara Membuat Warna Pada Latar Belakang 

  

 Maka akan muncul tampilan seperti gambar di bawah ini. Setelah 

selesai, klik OK. 

 
Gambar 3.26 Tampilan Page Properties 

  

 Tahap pembuatan latar belakang pada setiap halaman adalah sama 

hanya saja halaman lainnya menggunakan gambar background yang 

berbeda. 

• Membuat tabel. 

 Pada halaman ini, terdapat tabel, untuk membuat tabel tersebut. 

Pada dreamweaver klik  Table > Insert Tabel. Maka akan tampil 

seperti gambar di bawah ini. 

 

Gambar 3.27 Tampilan Table 



   

 Setelah itu akan tampil kotak dialog Insert table. Isi Rows, 

Columns, Cell Padding, Cell Spacing, Width, Border dan setelah 

semua sudah diisi, lalu klik OK. Tetapi hampir semua tabel dalam 

website ini menggunakan nilai border = 0 agar tidak terlihat, karena 

penggunaan tabel disini hanya sebagai pembatas tiap-tiap kolom pada 

halaman website  

 
3.28 Tampilan Insert Table 

 Dan untuk melihat dan mengubah berbagai objek atau teks dapat 

dilakukan dengan Properties (property inspector) yang berada di 

bagian paling bawah  dari ruang kerja dreamweaver mx. 

 
Gambar 3.29  Tampilan Properties Table 

 Tahap pembuatan table pada setiap halaman adalah sama dan yang 

membedakan adalah pada saat menginsert gambar di dalam table pada 

masing-masing halaman serta pada propertiesnya. 

• Membuat Image. 

 Pada halaman ini, juga terdapat image, untuk memasukan image 

tersebut. Pada dreamweaver di Object Panels klik  Common > 

Image.  

 
Gambar 3.30 Tampilan Image 



   

 Atau bisa juga dengan Hotkey : Ctrl + Alt + i. Kemudian akan tampil 

jendela Select Image. Lalu pilih image dan Setelah image sudah 

dipilih, lalu klik OK.  

 
Gambar 3.31 Tampilan Select Image 

 Untuk melihat dan mengubah berbagai objek atau teks dapat 

dilakukan dengan Properties (property inspector) yang berada di 

bagian paling bawah  dari ruang kerja dreamweaver mx. 

 
Gambar 3.32 Tampilan Properties Image 

 Setelah selesai memasukan gambar dan mengetikkan teks di 

halaman ini lalu save halaman ini dengan nama tengah.htm  

 
Gambar 3.33 Tampilan Frame Tengah.htm 



   

 Image juga bisa dijadikam link menuju halaman lain dengan cara 

membrowse halaman pada fasilitas “link” yang juga terdapat pada 

menu Properties. Tahap pembuatan image pada masing-masing 

halaman adalah sama dan yang membedakan adalah pada saat memilih 

image yang akan diambil untuk diletakkan pada masing-masing 

halaman. 

• Membuat Text Link 

Caranya hanya mem-Block text yang akan dijadikan link lalu 

browse halaman yang akan dijadikan tujuan link melalui Properties > 

Link  pada bagian bawah ruang kerja. Lalu klik OK. 

 

2. Mendisain frame atas.htm 

• Membuat latar belakang (background) 

 Caranya sama ketika mendisain halaman tengah.htm. Yaitu dengan 

mem-browse file gambar yang tersedia, hanya saja image yang 

dimasukan berbeda. Dalam hal ini image yang digunakan bernama 

tn_banner1anime.jpg dan atur agar gambar menutupi  

• Membuat teks berjalan. 

 Di dalam halaman ini, anda melihat keterangan yang berupa text 

berjalan, cara membuatnya adalah dengan memblok text dengan 

mouse, kemudian pada Object Panels klik show code and design 

views lalu ketikkan pada awal kalimat dengan <marquee 

behavior="alternate" width="300"> dan di akhir kalimat dengan 

</marquee>. Setelah itu klik kembali show design view. Tahap 

pembuatan text berjalan pada setiap halaman adalah sama, yang 

membedakan adalah nilai “width”-nya yang merupakan pengaturan 

panjang jarak animasi text untuk berotasi. 

• Setelah selesai lalu save dengan nama atas.htm. 



   

 
Gambar 3.34 Tampilan Frame Atas.htm 

 

3. Mendisain frame kiri.htm. 

 Klik frame yang akan di edit. 

• Membuat latar belakang  (background).  

  Cara pembuatannya sama dengan pembuatan latarbelakang pada 

frame tengah. Yang berbeda adalah file yang digunakan berbeda agar 

terjadi kontras antara frame tengah (main frame) dan frame kiri (left 

frame). 

• Menggunakan fasilitas Layer. 

Fasilitas Layer yang tersedia dapat digunakan untuk mengatur 

gambar (image), agar tidak bergeser ketika website di jalankan. 

Berbeda dengan tabel yang bisa juga digunakan untuk mengatur posisi 

gambar, posisi layer dapat dipindahkan dengan cara di-drag sesuai 

keinginan. 

Klik ikon draw layer yang tersedia pada menu Common, lalu drag 

frame yang akan di disain sebesar yang di inginkan. Kemudian drag 

gambar ke arah layer yang sebelumnya di buat, kemudian atur 

posisinya.     



   

 
Gambar 3.35 Tampilan Pilihan Draw layer 

 

 
                       Gambar 3.36 Tampilan Frame Kiri 

 

 Setelah seluruh halaman telah selesai dibuat, lalu klik batas terluar 

/  pinggir halaman. Jika tidak salah klik maka seluruh bingkai halaman 

akan berubah warna yang menandakan frame-set sudah terpilih, lalu 

save halaman tersebut. 

 Berikut ini adalah tampilan halaman menu utama secara 

keseluruhan yang telah selesai dibuat. 



   

 
Gambar 3.37 Tampilan Menu Utama Bagian Atas 

 
 Frame kiri ( kiri.htm )  Frame Tengah ( tengah.htm )   
 
 Frame Atas ( atas.htm )  
   

 
Gambar 3.38 Tampilan Menu Utama Bagian Bawah 

 

 

 

 



   

3.6.2 Pembuatan Halaman Kategori.htm 

Halaman Kategori.htm merupakan halaman halaman kedua dari kiri.htm 

dan juga merupakan halaman penghubung terhadap halaman-halaman 

SubKategori.htm. halaman ini hanya merubah tampilan halaman kiri.htm ketika di 

jalankan. 

Halaman ini hanya menggunakan teks-teks yang memiliki link ke 

halaman-halaman lain, dan halaman ini sendiri merupakan link dari kata “Pilih 

Kategori” yang terdapat pada halaman kiri.htm.  

Pembuatan halaman ini sangat mudah, halaman ini hanya menggunakan 

warna background = #FF9900, yang diatur melalui Modify > Page Properties. 

 
Gambar 3.39 Tampilan Menu Page Properties 

 

 
Gambar 3.40 Tampilan Halaman Kategori.htm 



   

3.6.3 Pembuatan Halaman SubKategori 

 Halaman SubKategori terdiri dari halaman Action.htm, Sport.htm, 

Fantasy.htm, Drama‘N Fun.htm, Detective.htm, Adult/Hentai.htm, Tokusatsu.htm, 

dan J-Movie.htm. Semua halaman tersebut memiliki disain yang sama, yang 

berbeda hanya teksnya saja. Oleh karena itu akan dibuat salah satu halaman saja 

sebagai contoh pembuatannya, dalam hal ini akan di buat halaman Action.htm 

sebagai contoh. 

Cara pembuatannya adalah :  

1. Klik menu Modify > Page Properties. Lalu browse background 

dengan nama BG-1 pada subfolder Gambar. 

 
Gambar 3.41 Tampilan Page Properties dan Image Source 

 

2. Ketik kata “# A C T I O N #” sebagai judul halaman, lalu beri warna 

text = #FF0000, dan Font Size = +7, lalu atur paragraf sebagai Align 

Center pada menu Properties.  

3. Buat tabel dengan banyak Columns = 5 dan Row sebanyak judul 

yang masuk kategori tersebut. Lima kolom tersebut masing-masing 

akan di isi dengan text : Judul anime, Type, Jumlah CD, Screen 

Capture, dan Rating. Dengan font colour = #006666. 

4. Untuk text judul, tipe, banyak cd, link screen captire, dan rating 

menggunakan Font Colour = #0000FF.  



   

5. Link-kan tiap-tiap judul dengan halaman anime sinopsis dari tiap-

tiap judul. Maka hasilnya seperti gambar di bawah ini. 

    
Gambar 3.42 Tampilan Disain Subkategori Action.htm 

Pembuatan sub kategori lain dilakukan dengan cara sama, hanya saja 

textnya yang berbeda. 

  
Gambar 3.43 Tampilan Halaman SubKategori Action.htm 

 

3.6.4 Pembuatan Halaman Anime List.htm 

Halaman AnimeList.htm merupakan hasil edit dari halaman Tengah.htm. 

halaman AnimeList.htm terdiri dari tabel, rollover image, image dengan link, dan 

text dengan link. Pembuatan rollover image dengan menggunakan fasilitas 

rollover image yang tersedia pada toolbar dremweaver pada menu Common. lalu 

isi menu Insert Rollover Image dengan alamat gambar yang ingin dibuat 



   

menjadi rollover image. Pembuatan “link di dalam halaman” dengan 

menggunakan fasilitas Anchor yang digunakan pada alfabet pada tiap-tiap huruf 

dan kemudian buat link menuju huruf tersebut pada halaman yang sama dengan 

mengetik tanda : #  pada awal adress link. Contoh : #a sebagai link ke tempat 

alfabet A berada dan seterusnya. Selanjutnya pembuatan tabel dan pemberian 

image caranya sama dengan pembuatan halaman yang lain. Hanya saja isi 

kandungan text dan link-nya yang berbeda, dikarnakan pada setiap judul yang ada 

pada halaman ini memiliki link menuju halaman sinopsis yang bersangkutan. 

 
Gambar 3.44 Tampilan Halaman Anime List.htm 

 

 Tombol link di dalam halaman 

 

3.6.5 Pembuatan Halaman Capture List.htm 

Cara pembuatan halaman Capture List.htm sama persis seperti cara 

pembuatan Anime List.htm. Yang berbeda adalah text pembuka dari halaman ini 

dan link dari setiap judul yang menuju ke halaman capture dari judul yang 

bersangkutan, selebihnya adalah sama. 



   

 
Gambar 3.45 Tampilan Halaman Capture List.htm 

 

3.6.6 Pembuatan Halaman Screen Capture.htm 

 Halaman ini adalah tampilan halaman yang akan muncul jika di-klik salah 

satu judul yang ada pada halaman Capture List.htm selain itu juga merupakan link 

dari salah satu text link yang ada pada halaman Sinopsis.htm. Halaman ini berisi 

text, gambar yang diambil dari folder image_capture yang dihasilkan dengan 

Photoshop lalu di edit dengan Easy Thumbnails untuk mengompres gambar agar 

byte-nya lebih kecil, background (yang digunakan adalah BG-4.jpg yang terdapat 

pada folder Gambar), dan text link. 

 
Gambar 3.46 Tampilan Halaman Screen Capture.htm 



   

3.6.7 Pembuatan Halaman Sinopsis.htm 

 Pembuatan halaman Sinopsis.htm hanya berisi text, gambar, dan text link. 

Penggunaan tabel disini hanya sebagai pembatas / ukuran besar halaman yang 

diinginkan, sehingga tabel menggunakan nilai Border=0, agar tabel tidak terlihat. 

Sedangkan gambar yang digunakan adalah gambar yang sudah di edit dengan 

menggunakan Easy Thumbnails. Halaman ini akan muncul jika salah satu judul 

yang ada pada AnimeList.htm maupun halaman Subkategori di klik. 

 
Gambar 3.47 Tampilan Halaman Sinopsis.htm Bagian Atas 

 

 
Gambar 3.48 Tampilan Halaman Sinopsis.htm Bagian Bawah 



   

3.6.8 Pembuatan Halaman Daftar Biaya Kirim.htm 

Halaman ini berisikan tabel yang merupakan daftar biaya kirim dari kota-

kota yang terdaftar pada jasa pengiriman barang “TIKI”. Halaman ini 

menggunakan text dan tabel serta Background yaitu BG-1.jpg. Halaman ini dapat 

di akses dari menu utama dan halaman kategori. 

 
Gambar 3.49 Tampilan Halaman Daftar Biaya Kirim.htm 

 

3.6.9 Pembuatan Halaman Pemesanan.htm 

Halaman Pemesanan.htm hanya berisi text saja  dan text link dari alamat 

e-mail yang dihubungkan dengan Microsoft Outlook dengan cara menamakan 

alamat link-nya didahului dengan mailto: dalam hal ini menjadi 

mailto:x_anime@doramail.com sebagai standar program untuk mempermudah 

pengiriman e-mail otomatis kealamat e-mail X~Anime. 



   

 
 Gambar 3.50 Tampilan Halaman Pemesanan.htm Bagian Atas 

 
 Gambar 3.51 Tampilan Halaman Pemesanan.htm Bagian Bawah 

 

3.6.10 Pembuatan Halaman About Us.htm 

Pembuatan halaman About Us.htm hanya menggunakan text, text link 

berupa alamat e-mail X~Anime, dan gambar animasi dengan nama 

A_comments.gif untuk memperindah tampilan halaman. 



   

 
   Gambar 3.52 Tampilan Halaman About Us.htm 

 

3.7 Uji Coba 

Uji coba ini dilakukan untuk melihat perkembangan terakhir dari website 

yang telah dibuat. Uji coba juga dilakukan sebagai sarana evaluasi sehingga dapat 

diketahui letak kekurangan dan kesalahan yang mungkin terdapat didalamnya. 

Untuk pembuatan website ini ada beberapa hal yang perlu diperhatikan 

untuk mendapatkan hasil yang sempurna. Hal yang perlu diperhatikan tersebut 

ialah mengenai spesifikasi teknisi system. Spesifikasi  teknisi sistem yang 

dimaksud disini adalah perangkat keras dan perangkat lunak yang saling 

mendukung dan memiliki kemampuan untuk menjalankan website x~anime ini. 

Disamping itu banyaknya image / gambar yang terdapat pada situs ini juga sangat 

mempengaruhi cepat atau tidaknya tiap-tiap halaman ketika di upload dari warnet 

umum. Maka untuk mengatasinya dapat digunakan software Easy Thumbnails 

untuk menurunkan kualitas dan ukuran semua gambar yang digunakan pada situs 

ini yang kemudian juga dapat mengurangi besar website secara keseluruhan. 

 

 

 



   

3.7.1 Hardware dan Software yang digunakan penulis. 

Spesifikasi Komputer agar dapat melihat hasil akhir dari website x~anime 

ini menggunakan atau membutuhkan spesifikasi komputer sebagai berikut : 

1. Proseser Intel Pentium IV / 1.7 GHz. 

2. Sistem Operasi Microsoft. Windows XP Professional. 

3. Memori RAM 384 MB 

4. Ruang kosong Harddisk sebesar 17 MB, untuk menyimpan isi seluruh 

website ini. 

5. VGA Card GeForce4 MX 440, 64 bit. 

6. Program Aplikasi Browser Internet Explorer 5.0 

 

Software yang digunakan adalah sebagai berikut : 

1. Macromedia Dreamweaver MX 

2. Adobe Photoshop 7.0 

3. Bannermaker Pro v5.0 

4. Easy Thumbnails 

 

3.7.2 Mengupload Website X~Anime 

Untuk dapat mempublikasikan website x~anime melalui internet, maka 

penulis mengupload website ini. Dalam hal ini penulis menggunakan situs 

Geocities untuk dapat mengupload file website x~anime. Untuk dapat 

mengupload file di dalam Geocities di haruskan mempunyai e-mail yang ada di 

Yahoo.  

Untuk itu terlebih dahulu harus membuat e-mail di Yahoo, langkahnya 

adalah: 

1. Masuk ke Program Microsoft Internet Explorer  

2. Ketikan situs www.yahoo.com 

3. Klik e-mail 

4. Kemudian setelah itu klik sign me up 

5. Setelah itu isi semua pertanyaan 

6. Klik submit 



   

Jika sudah membuat e-mail di Yahoo, kemudian dapat dilanjutkan dengan 

mengupload file melalui Geocities, adapun langkah-langkanya adalah : 

1. Buka Program Microsoft Internet Explorer atau Netscape Comunicator 

2. Kemudian ketikan situs www.geocities.com 

3. Pada yahoo ID ketikan nama file yang akan di upload berserta 

passswordnya 

4. Klik SIGN IN setelah itu klik I ACCEPT 

5. Kemudian klik upload FTP 

6. Masukkan semua file yang akan di upload 

7. Jika semua sudah dimasukkan klik Upload 

8. Lihat sebelah kanan jika sukses upload filenya maka klik File Manager 

9. Pada kotak Enter This Number ketikkan angka yang ada disampingnya 

10. Kemudian klik Submit This From 

11. Rename file utama yang kemudian dijadikan file index.html. 

 

 

                  

    


